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 28. HSC - DATABASES
 HSC Chemistry can handle two active databases simultaneously, denoted as the Own and
 the Main database. The current version of the Main database contains thermochemical
 data of more than 25000 species, including pure substances and aqueous species. The Own
 database is reserved for the data specified by the user. It is empty when the user gets the
 software, but up to 60000 species can be saved into one Own database.
 All the calculation options of HSC Chemistry utilize the same databases, and therefore
 they are an essential part of the program. In the database the enthalpy (H), entropy (S) and
 heat capacity (C) values of the elements and compounds are saved together with a variety
 of additional information.
 Note that HSC Chemistry primarily uses the Own database, file OwnDB7.HSC, if the
 same species is found in both files. It is not recommended, therefore, to edit the Main
 database, file MainDB7.HSC. It would be more convenient to save new data into the Own
 database. Any valid file names and directories can be used for the OwnDB7.HSC and
 MainDB7.HSC database files, and both can easily be changed.
 All HSC database files may usually be found from \HSC7\Databases folder. Old
 MainDB3.HSC, MainDB4.HSC, MainDB5.HSC and MainDB6.HSC files are included
 with the new MainDB7.HSC database file. Note that different basic thermochemical data
 may cause differences to the calculation results. For example, use of HSC MainDB4.HSC
 or MainDB5.HSC database files may lead to different calculation results. See Chapter 31
 for details.
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 28.1 Database Menu
 Fig. 1. The Database Menu.
 The Database Menu, Fig. 1, makes it possible to search for the species on the basis of
 given elements, list species, print data, edit old data, save new data, etc. It can also convert
 thermochemical data to the H, S and Cp formats for saving in the HSC-databases. You can
 select these options by pressing the appropriate buttons in the Database Menu.
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 28.2 Notations and Abbreviations used in the Database
 The chemical formulae are written using a standard formalism and as briefly as possible.
 However, there are some exceptions, because superscripts and subscripts cannot be used.
 These will be discussed in the following paragraphs in more detail. See also Chapter 34.
 Species, for a complete list of all the species in the Main database.
 Thermodynamic data for the solid and liquid phases of a substance is usually saved under
 the same formula name: for example, the formula Cu contains data for solid (fcc) and
 liquid copper. Gaseous substances, however, have their own records and their names have
 the extension (g), for example Cu(g).
 If the extension (l) is added to a chemical formula and such a substance is not found in the
 database files, HSC automatically searches the records for the liquid phase, extrapolates its
 H and S to 298.15 K, using the Cp data of the liquid, and saves the results with the
 extension (l) in the OWNDB7.HSC file. This permits extrapolation of the liquid data to
 lower temperatures. Be careful, however, when utilizing the extrapolated values as the
 method is purely mathematical, especially if the temperature of your system is far from the
 stable liquid temperature range of the species considered.
 Exceptions to the normal chemical notation are the formulae, which start with a
 stoichiometric number. An extra * character (for example *2MgO*SiO2) must be added at
 the beginning of such a formula.
 Because different composition coordinates have been used for aqueous species in the HSC
 database, they must be distinguished from other species with a similar stoichiometry. This
 is done using the suffix (ending) "a)" with uncharged aqueous molecules, radicals and
 ions, for example:
 H+ = H(+a)
 OH- = OH(-a)
 Fe+3 = Fe(+3a) etc.
 HSC also calculates the electronic neutrality of the system and therefore the suffix
 (ending) of an ionized species must also contain the charge, for example H(+a), OH(-a),
 Fe(+3a), etc. Ionized gaseous species are written using the similar formalism: Ar(+g),
 H2(+g), etc. Endings can also be used to distinguish compounds with a similar chemical
 formula, for example, different allotropic forms, organic isomers, etc. Here are some
 examples:
 C = Graphite
 C(D) = Diamond
 C8H10 = Dimethylbenzene
 C8H10(E) = Octadiyne
 Note that the endings must be inside parentheses. However, the use of lower-case letters s,
 l, g or a is not allowed, because they are reserved to distinguish the states of matter, i.e. the
 solid, liquid, gas and aqueous states.
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 28.2.1 HSC Formula Syntax
 An easy and illustrative specification method of species is needed in thermochemical
 calculations. In inorganic chemistry this is not usually a problem, because traditional
 formulae are quite short and illustrative. However, problems arise with some natural
 minerals with quite long and complicated formulae and especially with many extremely
 complicated organic species, for example:
 C6H4(COO(CH2)7CH3CH(CH3)2)2 = Diisodecyl phthalate.
 Species could be identified using chemical names, but these are very clumsy to use,
 Chemical Abstract numbers are not illustrative, structural formulae could be very long and
 cross formulae are not enough. These are the main reasons for the formula syntax which is
 used in HSC Chemistry 7.0. The basic idea of this syntax is described in the previous
 Chapter 28.2 and in Fig. 2. More details are given in the following paragraphs as well as in
 Chapter 29. Hydrocarbons for the organic species.
 Fig. 2. The chemical formula syntax used in HSC Chemistry 7.0.
 1. The maximum length of a formula is 24 characters. With simple inorganic species
 the traditional formula syntax can be used. However, if the structural formula with
 suffix is longer than 24 characters, then a cross formula must be used, see Fig. 2.
 2. Superscripts and subscripts cannot be used.
 3. Inner parentheses are not allowed, for example:
 H2(Sn(OH)6) is not a valid formula, use H2Sn(OH)6, instead.
 1. The last parentheses, at the end of the formula, are always reserved for the suffix,
 see Fig. 2. Therefore you cannot use the formula AlO(OH). Please write it in one of
 the following ways: AlO2H, AlO*OH or AlO*(OH).
 2. The last two characters specify the state if the last character of the formula is “)”.
 E.g. gas, liquid and aqueous identifiers must be at the end of the suffix. See the
 following examples and Fig. 2:
 As(g) Monoatomic arsenic gas
 O2(g) Diatomic oxygen gas
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 Fe(l) Liquid iron
 OH(-a) Aqueous OH ion (charge = -1)
 1. Gaseous species always need the “g)” suffix. The state identifier “s)” is not used for
 the solid species. Normally the liquid species are also written without the “l)” suffix,
 but sometimes an “l)” suffix must be added to the formula. See Chapter 28.11 for
 details, because incorrect selections may cause big errors.
 2. The charge of an ion must be written just before the state identifier with the correct
 plus or minus sign. For example: H(+a), SO4(-2a), O2(-g), etc., see Fig. 2. The
 phase code ao is used in the database for undissociated aqueous species (ions) and
 ai for aqueous electrolyte (neutral), which are formed from undissociated aqueous
 species. Note that the suffix “ia)” is used for the ai species and “a)” for ao ones.
 3. Identical cross formulae must be separated from each other using the identifier just
 before the charge and state identifiers, see Fig. 2. These identifiers should be
 constructed from the name of the substance. Substances with the same composition,
 but different crystal structure, can easily be separated from each other using only
 one character identifier. Note that the most common form of the substance is written
 without any suffix. For example:
 C Carbon
 C(D) Diamond
 FeS2 Pyrite
 FeS2(M) Marcasite
 The situation with organic substances is not as simple because there are a number of
 substances with the same cross formula. Therefore longer identifiers must be used,
 but it is recommended to keep the length of the identifier to three characters, see
 Fig. 2. In many cases the identifier must be longer, for example:
 C7H6N2O4(26DNTg) 2.6-Dinitrotoluene
 C7H6N2O4(34DNTg) 3.4-Dinitrotoluene
 Numbers can also be used in the identifier, but the last character of the identifier
 cannot be a number, because it might be confused with a charge, for example:
 CH2ClBr(CBM+2g), where +2 is a charge, see also Fig. 2 and Chapter 29.
 Hydrocarbons.
 1. The formula before the suffix can be written in many ways, usually the same syntax
 as in the original data source is used in the main database of HSC. However, in some
 cases there is no established and settled syntax for all the formulae and therefore
 sometimes a differerent syntax has been used in the HSC 7.0 database, for example:
 CaMgSiO4 = CaO*MgO*SiO2 Calcium magnesium silicate
 MgTi2O5 = MgO*2TiO2 Magnesium dititanium pentaoxide
 The new Find option in the database menu can be used to display all the formulae
 with the same elements and stoichiometry, see Fig. 1. The formula can be written
 using nearly any conventional syntax to find the species with the same
 stoichiometry.

Page 6
                        

HSC Chemistry® 7.0 28 - 6
 Antti Roine August 10, 2006 09006-ORC-J
 Another useful feature, which is in nearly all the calculation modules, is the
 possibility to check the name of any species in the database as well as collect
 formulae directly from the database, see Chapter 10. Reaction equations, Fig. 10.
 1. The formula cannot start with a number character. For example, 2MgO*SiO2 is not
 a valid formula, because the reaction equation module may confuse the first “2”
 character with the stoichiometric coefficient in a reaction. Please add an asterisk “*”
 character onto the beginning of such a formula: i.e. *2MgO*SiO2.
 Please note that you can easily check the name and other data of a species in most of the
 HSC modules by double clicking the formula in the list or using the right mouse button.
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 28.3 Reference States
 The reference state used in the databases is the most stable phase of the pure elements at
 298.15 K and 1 bar. The enthalpy and entropy scales of the elements are therefore fixed in
 HSC Chemistry by defining:
 H° = 0 at 25 °C and 1 bar.
 S° = 0 at 0 K and 1 bar (absolute entropy scale, third law scale).
 Previously the standard pressure was one atm, but more recently 1 bar has been adopted.
 This has negligible effect on H, S and Cp values at 298.15 K.
 The data of aqueous species is given for a theoretical 1 mol/kg H2O solution at 25 °C and
 1 bar, which is extrapolated from an infinite dilution on a molality scale. The aqueous ions
 have been saved using the conventions traditionally used in aqueous chemistry. The scale
 is fixed assuming that the enthalpy, entropy and heat capacity values, for a hydrogen ion
 (H+) at all temperatures, are zero in a hypothetical ideal, one molal solution (1 mol/kg
 H2O), i.e.:
 DH°(H+) = 0 DS°(H+) = 0 Cp(H+) = 0
 The different scales between aqueous ions and other substances in HSC database do not,
 however, cause inconveniences in the calculations, because HSC Chemistry makes the
 scale conversions automatically, if you remember to use the "a)"-extension with the
 aqueous species, with the proper integer and sign for the charge, i.e., (+a), (-2a), etc. Note
 however that the phase code ao is used in the database for undissociated aqueous species
 (ions) and ai for aqueous electrolyte (neutral), which are formed from undissociated
 aqueous species.
 28.4 Aqueous Ions
 The thermodynamic properties of aqueous ions are traditionally given only at 25 °C, which
 limits the use of calculations to room temperatures. Therefore HSC Chemistry extrapolates
 the heat capacity values of such ions to higher temperatures by an empirical correlation,
 the Criss-Cobble method, if the Criss-Cobble option is selected. This method has been
 described in the following references11-14.
 The Criss-Cobble method is only used if the temperature coefficients of the heat capacity
 function are not given in the HSC database. It is not used if B, C and/or D are given
 together with A. By using this method, it is possible to extrapolate the heat capacity and
 estimate their values up to 300 °C. According to previous references in literature11-14, the
 extrapolated Cp values have been found to be quite consistent with the experimental data
 available.
 HSC Chemistry makes some modifications to the data of aqueous ions:
 - The entropy scale of aqueous ions is changed to the "normal" absolute (Third law)
 entropy scale by subtracting 5 cal/(mol*K) from the hydrogen ion scale at 25 °C. This
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 is “the experimental entropy value for hydrogen ions” in the absolute scale14. This
 conversion is needed for Criss-Cobble extrapolation and it is invisible for the user.
 - The entropy values of aqueous ions contain the mixing entropy to a 1 molal solution.
 Therefore the entropy change R*ln xi = 1.987*ln(1/55.51) = 7.981 (cal/mol*K) may be
 subtracted from the entropy if a mole fraction scale is used for the aqueous solution.
 HSC introduces hypothetical "pure ion" entropies in the GIBBS-program, if the Mixing
 Entropy Conversion option is selected, Chapter 13.3 of the Equilibrium module, Fig. 5
 There are two types of neutral aqueous species in the HSC 7.0 database:
 1. "ao" as phase code: Data may not be calculated from the species.
 2. "ai" as phase code: Data may be directly calculated from the species.
 Phase code "ao" is used for undissociated aqueous species (usually ions) and "ai" for
 aqueous electrolyte (neutral) which is formed of undissociated aqueous species. The "ai"
 species has suffix "ia)" in the HSC 7.0 database but suffix "a)" in HSC 2.0 database. The
 number of "ai" species in HSC database is very small and most of them are from NBS 82
 data source.
 In the HSC Chemistry 7.0 these species may easily be separated without checking the
 Phase code from the database, because the "ai" species has a suffix "ia)" in the
 MainDB7.HSC database. For example, MnCl2(a) name has changed to MnCl2(ia) because
 it's phase code in the database is "ai".
 The enthalpy and entropy values of "ai" species may be calculated as a sum of its
 dissociated components, for example, enthalpy for MgSO4(ia) is:
 MgSO4(ia) = Mg(+2a) + SO4(-2a) = -465.960 +(-909.602) = 1375.562 kJ/mol
 This calculation procedure may not give exactly the same results as given for "ao" species
 in the HSC database due to the different original data sources for species. The H and S
 values for "ao" species such as MgSO4(a) can not be calculated in the same way. Note: It
 is recommended to use only "ao" species in the calculations.
 The reason for the differences in H, S and Cp values are usually because the HSC database
 is collected from 900 different data sources and there is lot of small differences with the
 original data for the same species in these sources. For example: HF(a), HF(ia), H(+a), F(-
 a) are from different sources.
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 28.5 Search Option
 Fig. 3. Search for species containing given elements.
 The HSC database menu offers two ways to find species from the databases. The first
 search option finds all the species, which contain some of the given elements, and species
 types can also be used as the search criteria. The second search option collects only those
 species, which contain all the given elements.
 The first search option makes it possible to find all the species, which contain given
 elements in the HSC Chemistry’s Own and Main databases. Use the following steps:
 1. Select one or more elements, Fig. 3. Press the element buttons or type directly into
 the text box. Try for example As, S, O.
 1. Select the substance groups, which you are interested in, from Search Mode. If you
 do not select the "Organic" option, all the species containing hydrogen together
 with more than 2 atoms of carbon will be ignored in the search. You can also set a
 limit for the number of carbon atoms in the species, for example 4, 6, 7 (up to 9
 numbers may be specified).
 Warning: In some cases inorganic species may also contain hydrogen and more than
 2 atoms of carbon.
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 1. Press OK and you will see the species found, see Fig. 7.
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 28.6 Finding Species with the same Stoichiometry
 Fig. 4. Finding species from the databases.
 This search option finds only those species, which contain all the given elements in the
 same proportion as in the given formula. This means that you can type the formula nearly
 any way you like, and elements can be written in any order. For example, if you type
 SiO4FeFe then you get the following species as a result:
 *2FeO*SiO2 Fayalite
 Fe2SiO4(B) Beta fayalite
 Fe2SiO4(G) Gamma fayalite
 If the Fix Ratio of Elements option is selected, Fig. 2, the program searches all the
 species with the same stoichiometry ratios. For example, if you type formula AsS into the
 input box, you might also get As2S2, As3S3, etc., see Fig. 5. If you do not select this
 option you get only AsS, AsS(l), AsS(g), etc.
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 Fig. 5. Results of a search using AsS key word (formula). Note that you can see the names and data of the
 species by double clicking the species formulae.
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 28.7 Listing Species Names
 Fig. 6. List Species Names option.
 With the List Names option you can retrieve a list of the species names, which exist in the
 Own or Main database. You may switch between the Own and Main database by pressing
 Main Database.
 If you press Show Data you will see the thermochemical data of the species selected, see
 Fig. 6. You can also go directly to the edit option by pressing Edit Data, see Fig. 7. Print
 Species List enables you to print the list of the database species on paper.
 An easy way to check the name and data of a species is to double click the formulae in the
 list using the mouse. This quickly shows the information of the species, see Chapter 10.
 Reaction equations, Fig. 10.
 By pressing Exit you return to the Database Menu, see Fig. 1.
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 28.8 Listing Species Formulae
 Fig. 7. Results of the species search made in Fig. 3.
 With the List Formulae option you can get a list of all the species formulae, which exist
 in the Own and Main Database or only of those, which contain the given elements. This
 example, Fig. 7, shows the results of the species search made in Fig. 3. All As, S and O
 containing species exist in the Main Database. No such species were found in the Own
 Database.
 Using Select Elements you may specify the elements for the search, whereas if you select
 the All option the list of all species in the databases will be displayed.
 If you press Show Data you can see the thermochemical data of the selected species, see
 Fig. 8. You may also go directly to the edit option by pressing Edit Data, see Fig. 9.
 Print Data will print the database content for the selected species on paper and by using
 Form Feed you will get the copy from the printer. You can also define how many Rows
 per Page you want. Print Species List makes it possible to print a list of database species
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 formulae on paper. You can switch between the Own and Main databases.
 An easy way to check the name and data of a species is to double click the formulae in the
 list using the mouse. This will quickly show the information required, see Chapter 10.
 Reaction equations, Fig. 10.
 By pressing Exit you can return to the Database Menu, Fig. 1.
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 28.9 Listing Species Data in the Own and Main Database
 Fig. 8. List of existing data in main database for As2O3.
 The Find Species with Key Word option displays the data, which exist in the Own or
 Main database. First, select the database from the Search From options in which you are
 interested. Then type the element or compound formula in the Formula box and press
 Enter key or Find to see the data.
 You may search data using Formula, Structural Formula, Chemical Name, Common Name
 or Chemical Abstract Number as a key word. You can make this selection in the Find
 What option list. Then you may type the key word and press Enter key or Find to see the
 data.
 If the All check box is highlighted, a complete list of all the entries containing the keyword
 will be displayed in a new window to the left. From this list it is possible to select the
 desired species by simply clicking on them. Only the first entry will be shown if the
 checkbox is empty. By clicking the Criss-Cobble check box, you can see the effect of the
 Criss-Cobble extrapolation on the heat capacity of aqueous ions if the heat capacity data is
 not available in the database, see Chapter 28.4.
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 Press Print to get a paper copy. Press Form Feed to get the paper out of the printer. With
 Copy you can copy the data into the Windows Clipboard and then paste it onto other
 Windows programs. Note that you must first select the copy area using the mouse and that
 you must select at least one cell.
 With Copy you can copy the data into the Windows Clipboard and then paste it onto other
 Windows programs. Note that you must first select the copy area using the mouse and that
 you must select at least one cell.
 If you press List you can see a list of all the species in the database and you may select any
 species to display its thermochemical data. By pressing Exit you will return to the
 Database Menu, see Fig. 1.
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 28.10 Editing Data in Own and Main Database
 Fig. 9. Editing data in the own and main databases.
 This option lets you view data in the Own and Main database easily by clicking the species
 formula in the list on the left side of the window. You can swap between the Own and
 Main Databases using the Option list in the top left corner of the window.
 You can edit any value and text if you have more accurate data available, you can also add
 or delete temperature ranges. However, you can save the new edited data only in the active
 Own Database file. If you want to save the data in the Main Database file, you may select
 this file to the Own Database file, see Fig. 18. The following lines give only brief
 instructions, for details see the next Chapter 28.11.
 1. Select Own or MainDB File from the option list at the top left corner. It is not a
 good idea to edit the original Main database. Instead, you can save the same species
 with more accurate data in your Own Database. HSC Chemistry always uses the
 data from the Own Database when available.
 2. Type the formula into the Formula box and press Read from: to select the source
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 database. Find Formula will search the closest match if the species does not exist
 in the database.
 3. Edit the data. You can type directly into the cell.
 4. Press Save to: to save the edited data. It is recommended to save the new data in the
 Own Database.
 5. Press Exit to exit from the Editing Window. You can return to the Formula List
 option by pressing List.
 Note that you can delete species from both databases by pressing Delete. You can toggle
 between calories and Joules with the Calories and Joules options.
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 28.11 Saving Data in Own Database
 Fig. 10. Saving new data in the active Own Database.
 The HSC database editor can be used to show and edit species data of the active Own and
 Main Databases. The data can be selected for editing using two procedures:
 - The editor will show the data of a selected species in the list on the left side of the
 editor window, selection can be made using the mouse. Select the database by using
 the option list box at the top left corner of the editor window, see Fig. 10.
 - Another way is to type the formula of the species in the Formula box in the upper
 row of the window and press Read from:. The editor will show the data if it is
 found from the selected database, which is shown on the right side of the button.
 The user can also type the new data directly in the blank database editor window. It is
 recommended to save the data of a new species or the edited data of an old species in the
 Own database. The saving must be done using Save to: on the bottom row of the editor.
 This button will save the data into the database, which is displayed on the right side of this
 button.
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 In HSC-databases, the data is given as sets of temperature intervals. One H, S and Cp data
 set is valid only within a certain temperature range, which normally corresponds to a
 thermodynamic phase. Follow these steps when you save new data in the HSC Own
 Database. The most important steps have been underlined:
 1. Clear input fields
 First clear the Database Editor by selecting Clear All from the Edit menu.
 2. Units (Essential)
 You must decide which energy units you want to use; make this selection with the
 Calories and Joules options. Kelvins must always be used as temperature.
 3. Formula (24 Characters, Essential)
 The formula must always be given. The valid formula syntax is described in Chapter
 28.2.1. The database editor will automatically calculate the molecular weight when
 you type the formula and press Enter.
 The use of the correct state identifier (g, l, a, etc.) is extremely important, because
 the calculation modules handle the species in different ways. The state identifier
 “g)” must always be used for a gaseous species and “a)” for an aqueous species.
 Solid species must be given without the state identifier “s”. Liquid species and
 different structural forms can be specified in two ways:
 A. One formula for liquid and solid phases
 This format is traditionally used for inorganic species, see example in Fig. 10.
 Solid and liquid copper sulfides, as well as its different crystallographic
 forms, have the same formula Cu2S in the database. It is extremely important
 to note that:
 The enthalpy H value in the first temperature range must be the heat of
 formation of solid Cu2S at 298.15 K and 1 bar.
 The entropy S value in the first temperature range must be the standard
 entropy of solid Cu2S at 298.15 K and 1 bar.
 The enthalpy H value in the following temperature ranges must be the heats of
 phase transformation at the phase transformation temperature. The following
 phase transformations can be seen in Fig. 10:
 - 376 K: Orthorombic a-Cu2S -> hexagonal b-Cu2S
 - 720 K: Hexagonal b-Cu2S -> cubic g-Cu2S
 - 1400 K: Cubic g-Cu2S -> liquid Cu2S
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 The entropy S values in the following temperature ranges are the entropy
 changes in the phase transformations. Note that DtrS can be calculated from
 the corresponding DtrH values using equation (1) at the transition temperature
 Ttr. One must keep in mind that this relation is not valid for the heat of
 formation and standard entropy values at 298.15 K.
 DtrS = DtrH / Ttr [1]
 B. Different formulae for liquid and solid phases
 The same data can also be given using different formulae for each substance.
 The copper sulfide data in Fig. 10 may be divided into four separate phases:
 Cu2S(A), Cu2S(B), Cu2S(C) and Cu2S(l). It is, however, extremely important
 to note that for each phase:
 The H value in the first temperature range must always be the heat of
 formation of solid Cu2S(A), Cu2S(B), Cu2S(C) or liquid Cu2S(l) at 298.15 K
 and 1 bar.
 The S value in the first temperature range must always be the standard
 entropy of solid Cu2S(A), Cu2S(B), Cu2S(C) or liquid Cu2S(l) at 298.15 K
 and 1 bar, respectively.
 The enthalpy and entropy change values for phase transformations cannot be
 used. The heat of formation and standard entropy values for each state must
 be extrapolated from the normal stability range down to 298.15 K.
 Quite often the heat of formation and standard entropy values for organic
 species are given for gas, liquid and solid phases separately at 298.15 K.
 These values can easily be saved in the HSC database. However, different
 formulae must be used for each phase. See, for example, solid Tert-butyl
 alcohol C4H10O(TBA), liquid C4H10O(TBAl) and gaseous C4H10O(TBAg)
 in the HSC Main Database.
 4. Structural Formula (32 Characters max)
 The structural formula is not utilized by the calculation modules, but it can be used
 to specify the species. It may also be used to save normal formula synonyms.
 5. Chemical Name (52 Characters max)
 The chemical name is not needed in thermochemical calculations, but it is very
 useful when selecting species for the calculations. Please use lower case characters,
 but start with an upper case character, see example in Fig. 10.
 6. Common Name (32 Characters max)
 Usually substances have a short common name, which is used instead of the long
 chemical name. Mineralogical, trade, etc. names as well as synonyms can be used.
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 Please try to use the most common ones in the HSC databases. Please use lower case
 characters, but start with an upper case character.
 7. Chemical Abstract Number (12 Characters max)
 The Chemical Abstract number is one precise way to specify substances. However,
 this number is not usually available in the original references of the HSC database,
 therefore this data is partly defective in HSC 7.0. However, this data field gives the
 user the possibility to use CAN numbers in his Own Databases.
 8. Molecular Weight (Number, Essential)
 You can type the molecular weight in this data field. However, this is usually not
 necessary, because the Database Editor calculates the value automatically if you
 press Enter in the Formula field. The molecular weight must be given, because the
 calculation modules use the MW values in the amount unit conversions.
 9. Melting and Boiling points (Number)
 This data is not used by the calculation modules. However, the values can help a lot
 when analyzing the calculation results. Negative values mean that the substance
 decomposes before the melting or boiling point.
 10. Temperature Range T1 - T2 (Number, Essential)
 The valid temperature range must always be given for the H, S and Cp data, because
 calculation modules use these temperatures in nearly all calculations. The basic idea
 of temperature ranges is described in the previous Formula paragraph. Remember
 also that:
 - The first limit T1 is the lowest temperature where the Cp data A, B, C and D
 are valid. Traditionally the first temperature range starts from 298.15 K (=
 T1). However, other temperatures may be used.
 - The second temperature T2 is the highest temperature where the Cp data A,
 B, C and D are valid.
 - Quite often the upper limit T2 is the phase transformation temperature.
 However, sometimes the heat capacity temperature dependence of a phase is
 so complicated that it has been divided into several ranges. In these cases the
 phase transformation enthalpy and entropy values are zero (0).
 - The temperature ranges of a substance and formula must be continuous. No
 discontinuities are allowed.
 11. Phase (2 Characters, Essential)
 The correct state code must be given for the species: g for gases, l for liquids and s
 for solids. The code ao is used for undissociated aqueous species (usually ions) and
 ai for aqueous electrolyte (neutral), which are formed from undissociated aqueous
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 species. The ai species has suffix “ia)” in HSC database.
 The enthalpy and entropy values of ai species may be calculated as a sum of its
 dissociated components, for example enthalpy for MgSO4(ia) is:
 MgSO4(ia) = Mg(+2a) + SO4(-2a) = -465.960 +(-909.602) = 1375.562 kJ/mol
 This calculation may not give exactly the same results as given for ao species in the
 HSC database due to different original data sources. The H and S values for ao
 species such as MgSO4(a) can not be calculated in the same way. It is recommended
 to use only ao species in the calculations.
 12. H (Number, Essential)
 The first enthalpy value at 298.15 K and 1 bar must always be the heat of
 formation of the same state as described in the formula and phase fields. If there are
 several temperature ranges, the other H values are the heats of tranformations at the
 phase transformation temperatures. Note that the heat of formation for elements is
 zero at 298.15 K.
 13. S (Number, Essential)
 The first entropy value at 298.15 K and 1 bar must always be the standard entropy
 of the same state as described in the formula and phase fields. If there are several
 temperature ranges, the other S values are the entropies of phase tranformations at
 the transformation temperatures.
 14. A, B, C and D (Numbers)
 These values are the coefficients of the heat capacity function, see Chapter 8.
 Introduction, equation 4. These coefficients are not needed if thermochemical
 calculations are done at 298.15 K or near that temperature. At other temperatures it
 is essential to know this data.
 Quite often A, B, C and D coefficients are not available, and the heat capacity
 values are listed as a function of temperature only. These values can easily be
 converted to A, B, C and D coefficients using the Cp Fitting option of the database
 menu.
 Sometimes the coefficients A, B, C and D are given for other heat capacity functions
 than used in HSC Chemistry. Their coefficients can also be converted to HSC
 format using the Cp fitting option of the database menu.
 15. Density (Number)
 The calculation modules use density values in the mol - kg - Nm3 - conversions.
 However, missing density values do not usually cause too much trouble. Kg/l units
 have been used for the condensed species and g/l for gases.
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 16. Color (Number)
 Color of the substances is given using the color code. See Chapter 28.18 for color
 codes. "0" - value means that data is not available.
 17. Solubility (Number)
 These values are not yet available in HSC 7.0. This field is provided in order to
 guarantee the compability of the database with future versions of HSC.
 18. Reference (36 Characters)
 It is always recommended to also give the original reference of the data. There are
 only 36 characters available for the references and therefore abbreviations must be
 used. The abbreviations are formed using the author name and the year of
 publication. The Main Database abbreviations are given in alphabetical order in
 Chapter 33. Data references.
 19. Reliability Class (Number)
 The data in the HSC Main database have been collected from a large number of
 sources. Especially in some old sources, the accuracy of the H, S and Cp data does
 not seem to be so good. However, all this data has been included in the Main
 database, because in some cases small errors in the basic thermochemical data are
 not critical.
 The Reliability class gives a rough estimate of the reliability of the data. The best
 reliability code is 1 and worst is 10. Usually, new data books’ have a reliability class
 of 1. The user can easily edit the reliability class of different references using the
 Class option in the Edit menu. The reliability class offers one additional key word,
 which can be used to sort species.
 You can insert and delete temperature ranges with the Column options in the Insert and
 Delete menus. You can switch between calories and Joules with cal. However, all values
 are saved as calories in the database. By using List you can go directly to the List
 Formulae option. With the Fit Cp Data button you can go to the Cp Fitting module. With
 Exit you can return to the Menu.
 Save to: will save the data shown in the database editor in the database shown on the right
 side of this button. You can get a paper copy of the data with Print and Form Feed
 options in the File menu.
 If you save new data in your Own database, please send your OwnDB.HSC file with its
 literature references to Outotec Research (address on the first page). We can then later add
 this novel pure substance data to the Main database and distribute it to other HSC users.
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 28.12 Fitting Cp Data
 Fig. 11. HSC database Cp Fitting module with NaF Cp data.
 Quite often only the heat capacity values at different temperatures are available. You can
 convert these data to A, B, C and D coefficients using the following procedure:
 1. Select Calories or Joules.
 2. Select Clear All from the Edit menu.
 3. Type the lower and upper limits of the temperature ranges to the T1 and T2 cells,
 for example: 298.15 and 1265 K, 1265 and 2000 K.
 4. Press Calculate Cp using Step:. This will automatically calculate the temperatures
 to the T - Cp - table on the left side of the window using the given temperature step.
 Note that you can also type and edit these temperatures manually.
 5. Type the heat capacity values to the Cp exp column.
 6. Select the Cp Range which you want to fit, from the list under Fit Cp Range:. If
 you only want to fit some of the coefficients then type “N” to other cells. See the
 example in Fig. 11.
 7. Press Fit Cp Range:.
 8. You will get the fitted A, B, C and D coefficients to the table on the right side of the
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 window. The fitting option will also calculate the Cp data using the fitted
 coefficients in the Cp fit column. It will also calculate the difference (Error %)
 between the “experimental” and the calculated value.
 Usually the Cp ranges are the same as the phase stability ranges. However, if the
 error % is too high, then you can try to divide the temperature range into even
 smaller parts. Diagram will show the results in a graphical format.
 1. When all the ranges have been fitted, you may copy the coefficients to the database
 by pressing Save to Database, see Chapter 28.11.
 28.13 Converting Cp Functions
 Fig. 12. Converting Cp functions to the HSC format.
 In some references the Cp coefficients A, B, C, D, etc. are based on another Cp-expression
 than that used in HSC Chemistry. The coefficients cannot be saved into the HSC
 databases. They can be converted to the HSC format using the following procedure:
 1. Select Calories or Joules for the converted A, B, C and D, i.e. for the results.
 2. Select Clear All from the Edit menu.
 3. Select the Cp formula from the list under the Set Cp Formula for Cp Range and
 press Set Cp Formula for Cp Range or type the formula manually into the Cp
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 Funct. cell.
 4. Type the unit string in the Units row, for example J/(kmol*K), i.e. the units of
 original coefficients.
 5. Type the lower and upper limits of temperature ranges into T1 and T2 cells, for
 example: 298.15 and 1500 K.
 6. Type the Cp function coefficients A, B, C, D, etc. into the correct Cp Range column.
 7. Press Convert Cp Functions to HSC Format. This will automatically divide the
 given Cp Range into 10 parts and calculates the Cp values at these temperatures.
 Then the conversion procedure continues in the same way as in Chapter 28.12. The
 results will be shown in the same way as in Fig. 11.
 8. When all the ranges have been converted, you may copy the coefficients to the
 database by pressing Save to Database and continue as described in Chapter 28.11.
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 28.14 Converting Thermochemical Data to H, S and Cp format.
 Fig. 13. Converting G(T)-function to H, S and Cp format.
 For some substances only Gibbs energy G values are available in the literature as a
 function of temperature. You must convert these values to H, S as well as to Cp
 coefficients A, B, C and D if you want to save them in HSC Chemistry databases.
 Conversion is simple:
 1. First select Calories or Joules from the option boxes.
 2. Then select Delta G(T) or G(T) format, depending on your original data, with Delta
 G(T).
 3. If you have selected the Delta format, please write the corresponding formula in the
 Formula box, i.e. Cu2S.
 4. Type the coefficients of the G(T)-function in the upper boxes of the window.
 5. Press Convert to get the corresponding Delta H, S, A, B, C and D in the lower
 boxes.
 6. Press Delta to Normal to convert the delta H, S, A, B, C and D to the “normal”
 values, which can be saved in the HSC database.
 7. Press Save HSC to transfer the data into the Database Editor.
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 With the Convert option you may also calculate ∆fH and ∆fS values as well as the Cp-
 coefficients of a reaction, ∆A, ∆B, ∆C and ∆D, to the enthalpy of formation Hf(298.15),
 standard entropy S°(298.15) and Cp coefficients A, B, C and D for saving in the HSC
 database. You must only give the Formula and delta values, as the Delta to Normal
 button automatically creates the correct chemical reaction for the formation.
 You can copy the data to other Windows programs with Copy. With Print and Form
 Feed you will get a paper copy of the data. The Clear option clears all the cells. With
 Find from HSC Database you can read data from the HSC databases onto the screen if
 you have first given the chemical formula. The Criss-Cobble option forces HSC to
 extrapolate the Cp values of aqueous ions using the Criss-Cobble method, see Chapter
 28.4.
 The conversion of ∆H, S, A, B, C and D to normal values can also be done manually.
 Calculations have been carried out in the following example. The reaction for formation of
 Cu2S, with pure copper and condensed sulfur as the raw materials will be:
 2Cu + S = Cu2S
 ∆Gr = -14.394 - 86.625e-3T + 13.574e-3TlnT - 17.817e-6T^2 - 185.3T^-1
 h s a b c d
 -14.394 -86.625 13.574 -17.817 -185.3 0
 Press the Convert button, Fig. 13:
 Delta H Delta S Delta A Delta B Delta C Delta D Delta G
 kcal/ cal/ cal/
 mol mol*K mol*K
 -18.100 4.252 -13.574 35.634 3.706 0.000 -19.368
 From these ∆H, ∆S and ∆Cp values you must solve the H, S and Cp values of Cu2S. You
 can find the H, S and Cp data of Cu and S in the HSC database:
 H(Cu2S) = ∆Hr + 2H(Cu) +H(S) = -18.100 + 2*0 + 0 = -18.100 kcal/mol
 S(Cu2S) = ∆Sr + 2S(Cu) +S(S) = 4.252 + 2*7.926 + 7.662 = 27.766 cal/(mol*K)
 A B C D
 ∆Cp = 1* ( -13.574 35.634 3.706 0 )
 Cp(Cu) = 2* ( 7.308 -2.707 -0.785 2.342)
 Cp(S) = 1* ( 4.011 4.794 0 0 )
 -----------------------------------------------------
 Cp(Cu2S) = 5.053 35.014 2.136 4.684 cal/(mol*K)
 These "normal" H(Cu2S), S(Cu2S) and Cp(Cu2S) values can be saved in the OwnDB.HSC
 database.
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 28.15 Convert Database File Format
 Fig. 14. Database manipulation module.
 This module is intended only for advanced HSC Chemistry users, who work with database
 development. This module offers tools for combining databases, sorting species in the
 databases, recalculating molecular weights, file conversions, etc. These kinds of operations
 are not needed at all with normal HSC calculations.
 One important option is the database sorting routine in the Sort menu. The species must be
 in descending alphabetical order according to elements in the formula. Usually HSC 7.0
 keeps this order automatically in the database, but if you have old HSC 2.0 databases
 converted to HSC 7.0 format or data file made by convert module, Fig. 14, you must sort
 these files in alphabetical order using the Sort option, see Fig. 15.
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 Fig. 15. Sorting an old HSC database file in alphabetical order according to elements. Please note that you
 have to convert this file first to HSC 7.0 format before applying the sorting option.
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 Fig. 16. Combining two HSC database files.
 One important routine is the HSC1 to HSC2 file option in the Insert menu. This option
 will insert a species in one database, for example, HSC1.HSC to a second database
 HSC2.HSC. It will overwrite the species in the HSC2-database if the same species exists
 in both databases, see Fig. 16. Both files must be in sorted into alphabetical order with the
 Sort selection before the Insert procedure is selected.
 If the Show Duplicates option is selected, Fig. 16, the program will show the data for the
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 duplicate species for both files and you have an opportunity to select better data with Take
 Source Data or Take Target Data. You can also edit data before the final selection is
 made.
 File menu offers several options, which can be used to read and save the HSC database
 files in different file formats. The same kind of file conversions can also be done using the
 Convert menu.
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 28.16 Converting old HSC 2.0 Databases to HSC 4.0 Format
 Fig. 17. Converting old HSC 2.0 Main database to HSC 7.0 format.
 You cannot use HSC 2.0 databases directly in HSC 7.0. You must first convert them to
 HSC 7.0 format. If you select Convert old Databases to new Format in the Database
 Menu, see Fig. 1, you will get to the Convert window, see Fig. 17.
 You must first select the old HSC 2.0 database file by pressing Select HSC 2.0 Database
 and then you must press Convert to HSC 3.0 Format to carry out the conversion.
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 28.17 Selecting Active Databases
 Fig. 18. Changing the active database.
 Two databases can be open at the same time. They are called the Own and the Main
 database. Nearly any valid file name and directory can be used. However, the suffix (type)
 of these files must be *.HSC (Note: Awdb4.HSC file is in HSC internal use). HSC
 Chemistry calculation modules primarily use the data in the Own database. If a species is
 not found from the Own database the HSC tries to find it from the Main database.
 Active databases can be changed at any time by pressing Select Active Databases in the
 Database Menu, see Fig. 1. The active databases can be selected using Open Own DB and
 Open Main DB. Sometimes, especially when working with old HSC 2.0 files it is
 recommended to also press Refresh Catalogue after opening the file. This will make a
 separate *.CAT file which helps HSC Chemistry to find the correct species in the
 database. Print Catalogue will print this *.CAT file.
 Active databases can be saved using different names using Save Own DB and Save Main
 DB. You can easily create a new empty HSC 7.0 database file using Create New
 Database.
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 Number of Species will give the number of different species in the database. The number
 of species is usually smaller than the number of temperature ranges in the file, because
 some species have several temperature ranges.
 28.18 Color Codes
 The color of the substaces is given for some species with the following color codes in HSC
 7.0 main database:
 0. No data available
 1. Blue
 2. Green
 3. Cyan
 4. Red
 5. Magenta (blue-red)
 6. Brown
 7. White
 8. Dark Grey
 9. Light Blue
 10. Light Green
 11. Light Cyan
 12. Light Red
 13. Light Magenta
 14. Light Yellow
 15. Bright White
 16. Colorless
 17. Yellow
 18. Grey
 19. Black
 20. Orange
 21. Yellow-grey
 22. Yellow-brown
 23. Red-brown
 24. Orange-yellow
 25. Yellow-green
 26. Black-brown
 27. White brown
 28. Orange-green
 29. Blue-green
 30. Dark-green
 31. Blue-black
 32. Red-orange
 33. Yellow-orange
 34. Green-yellow
 35. Brown-black
 36. Green-blue
 37. Orange-red
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 38. Brown-yellow
 39. Dark-red
 40. Brown-violet
 41. Red-violet
 42. Violet-black
 43. Yellow-black
 44. Blue-white
 45. Red-black
 46. Green-black
 47. Purple-black
 48. Grey-brown
 49. Brown-red
 50. Gold-brown
 51. Gold-yellow
 52. Blue-grey
 53. Orange-brown
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